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Notes, Notices, and Cautions 
 

 NOTE: A NOTE indicates important information that helps you make better use of your computer. 

 
CAUTION: A CAUTION indicates either potential damage to hardware or loss of data 
and tells you how to avoid the problem. 

 WARNING: A WARNING indicates a potential for property damage, personal injury, or 
death. 

Information in this document is subject to change without notice. Some of the information contained in this 
document may not apply to all Dell systems. 
© 2009 Dell Inc. All rights reserved. 

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden 

Trademarks used in this text: Dell, the DELL logo, Latitude, TravelLite, Wi-Fi Catcher, and ExpressCharge, are trademarks 
of Dell Inc.; Intel, Pentium, Celeron and Core are registered trademarks of Intel Corporation; Bluetooth is a registered 
trademark owned by Bluetooth SIG, Inc. and is used by Dell under license; TouchStrip is a trademark of Zvetco Biometrics, 
LLC; Blu-ray Disc is a trademark of the Blu-ray Disc Association; Microsoft, Windows, Windows Server, MS-DOS, Aero, 
Windows Vista. and the Windows Vista start button are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries. 

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and 
names or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own. 
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1 XT2 XFR Features 

1.1 XT2 XFR User Modes 

1.1.1 Notebook Mode 
Your XT2 XFR can be used either in notebook mode or tablet mode. To use your XT2 XFR in notebook 
mode, open the display until it reaches a comfortable viewing angle as in the image to the above, and 
use the keyboard and display as you would those of any other notebook computer. 
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1.1.2  Tablet Mode 
Your XT2 XFR converts from notebook mode to tablet mode with a 180-degree clockwise twist of the 
display’s rotating hinge. 
 

 CAUTION: Forcing the hinge beyond the 180-degree point will damage the XT2 XFR.  

  
 

 

Open the display of the XT2 XFR 
until it reaches a 90-degree angle, 

perpendicular to the base. 

Brace the base with one hand 
on the palm rest, grasp the top 

of the display with the other 
hand, and turn the rotating 
hinge clockwise 180 degrees 

until you feel the display engage 
securely. 

Lay the display assembly on the 
base with the display facing 

upwards. Press the latch down to 
secure the display. 

 
When you convert your XT2 XFR between notebook and tablet modes, the screen orientation of your 
XT2 XFR will automatically change according to the settings you have established in the Dell Control 
Point System Manager application or the Windows Vista Pen and Tablet settings application, most 
commonly from landscape (notebook mode) to portrait (tablet mode). 
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1.2 XT2 XFR Buttons 

1.2.1 Tablet Buttons 
Your XT2 XFR has three tablet buttons located beside the power button. In order for these buttons to 
function properly, Dell Control Point System Manager must be installed.  

 

 

 

1 Power Button 3 Screen rotate 
button 

2 Windows 
security button 4 Dell Control 

Point button 

 

 

Power button — Used to power the system on and off. 
Windows Security button — If you use your XT2 XFR in tablet mode, press this button to access the 
Windows Task Manager dialog box or a login screen, the same way you use the <Ctrl><Alt><Del> 
key sequence in notebook mode. 
Screen rotate button — While the XT2 XFR is in tablet mode, use the screen rotate button to change 
the display orientation from portrait to landscape mode. Each time you press and release the screen 
rotate button, the screen image rotates clockwise 90 degrees. 
Dell Control Point tablet settings button — Press this button to view and configure options for the 
XT2 XFR and the pen through Dell Control Point System Manager. You can configure this button to 
perform a different action using Windows Vista™ XT2 XFR Settings. 

1.2.2 Scroll Buttons 

 
 

1 Scroll control 2 Back button 

 

1.2.2.1 Using the Scroll Control 
To scroll through a list of items or a set of pages one at a time, shift the scroll control up or down and 
release. The control automatically returns to the center/neutral position when released.  
To rapidly scroll through a list of items or a set of pages, shift the control up or down and hold it, 
releasing it when you wish to stop scrolling.  

1         2         3         4 

    1         2 
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To select objects, press and release the scroll control when it is in the center/neutral position.  
To launch context sensitive menus, press and hold the scroll control until a complete circle is drawn on 
the display then release. This is equivalent to clicking the right mouse button on a notebook computer. 
 
Use the back button to move backwards in applications that support navigation, such as web browsers 
and Windows Explorer. It is also used to close the active window. 
 
To move backward, press and release the back button.  
To close the active window, press and hold the back button.  
To customize the back button behavior, use the Tablet and Pen Settings in Windows Vista. 

1.3 XT2 XFR Interface 

1.3.1 Windows Vista/XP XT2 XFR Interface Comparison 
Depending on the configuration you ordered, your XT2 XFR shipped with either the Windows Vista or 
Windows XP operating system. There are several differences in the Tablet PC-interfaces between the 
two. Listed below are the primary differences.  
 

Tablet PC Interface Comparison Table 

Feature Description Vista XP 

Touch Ability to use finger as an input device. YES YES 

Windows 
Journal 

Native note-taking application which takes input directly from pen or touch. YES YES 

Snipping 
Tool 

Tool used to capture portions of visual data (documents, pictures, etc.) via 
pen or touch.   *Available as a separate download from Microsoft.

 
YES YES* 

Flicks Gesture activated shortcuts for common tasks. YES NO 

Check 
Boxes 

Visual identifier in folders for selecting files. YES NO 

Cursor 
Feedback 

Visual indicator for tap location. YES NO 

Tablet 
Input 
Panel 

Tool used to input data via pen or touch that takes the place of a keyboard. YES YES 

Input 
device-

sensitive 
tools 

Tablet Input Panel and icon change size according to pen or touch being 
used. 

YES NO 

Tablet 
Cursor 

Special Tablet cursor used for Tablet PC functions as opposed to a standard 
mouse pointer. 

YES NO 

Touch 
Widget 

Separate tool that appears in Touch Mode used for right-clicking purposes. YES NO 

Cursor 
Feedback 

Ability to see if the target has been hit by using visual feedback for success. YES NO 

Cursor 
Feedback 

Ability to see if the target has been hit by using visual feedback for success. YES NO 

1.3.2 Windows Vista 

1.3.2.1 Pen Usage 
Using the Pen as a Mouse 

You can use the pen the same way you use a mouse or touch pad with a notebook computer. Holding 
the pen near the display makes a small cursor appear. Moving the pen moves the cursor. 
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The table below describes how to use the pen. 

Electrostatic Pen Usage 

Appearance Action Function 

 

Gently tap the pen tip on the screen of your Tablet PC. 
Same as a single-click on a 
mouse. 

 

Gently tap the pen tip twice in quick succession on the 
screen of your XT2 XFR. 

Same as a double-click on a 
mouse. 

 

Touch the pen on the screen and hold it in place 
momentarily until Windows draws a complete circle 
around the cursor. 

Same as a right-click on a 
mouse. 

 
Working With Files 

You can open, delete, or move many files or folders at 
one time by selecting multiple items from a list. Using 
a tablet pen, hover over one item at a time and select 
the check box that appears to the left of each item. 
 
To turn check boxes on: 
 

1. Go to Folder Options.  
2. Click on the View tab.  
3. Under Advanced settings, select the Use 

check boxes to select items check box, and 
then click OK. 

 
 

 
Using the Pen as a Pen 

The Windows Vista handwriting recognition software makes it easy to enter text into your applications 
with the pen. Some applications, such as Windows Journal, allow you to write with the pen directly 
into the application window. 
 

XT2 XFR Input Panel 
When an application does not directly support pen input, you can use the Tablet PC Input Panel to 
enter text into your application. If you tap in an editable area, the Tablet PC Input Panel 
icon appears. Tapping the icon makes Input Panel slide out from the edge of the display. 

 
You can also open the Input Panel by tapping the Input Panel tab, which is 
docked at the edge of the screen when the Input Panel is hidden. 
 
 
 
 

You can move the Input Panel tab by dragging it up or down along the edge of the screen. Then, when 
you tap it, the Input Panel opens at the same horizontal location on the screen that the tab appears. 
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You can use the writing pad, the character pad, or the on-screen keyboard to enter text. The writing 
pad and the character pad convert your handwriting into typed text. The on-screen keyboard works 
just like a standard keyboard except that you enter text by tapping keys with your tablet pen. The 
following table describes the different choices for using the Input Panel.  
 

Input Panel Icons 

Icon Name Function 

 Writing Pad 
With the writing pad, you can write continuously as if you were writing on a 
lined piece of paper. 

 Character Pad 
The character pad converts your handwriting to typed text, one letter, 
number, or symbol at a time. 

 
On-screen 
Keyboard 

The on-screen keyboard is similar to a standard keyboard.  

 
The writing pad and character pad have a number pad, a symbol pad, and web quick keys to help you 
quickly and accurately enter these types of text. These quick keys are hidden when you start to write, 
but appear after you insert or delete your writing. 
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Pen Flicks 
 
Pen flicks enable you to use the pen to 
perform actions that normally require a 
keyboard, such as pressing <Page Up> or 
using the directional arrow keys. Pen flicks 
are quick, directional gestures. You simply 
quickly draw a short line in one of eight 
directions. When a pen flick is recognized, 
the XT2 XFR performs the action assigned. 
The image below depicts the default pen 
flick settings. These can be customized by 
going to StartControl PanelPen and 
Input Devices and clicking on the Flicks 
tab.  
 

 
 
 
 
 
 

1.3.2.2 Touch Usage 
One of the key advantages of the XT2 XFR is the ability to easily switch from pen input 
to touch input.   When you use Touch Mode, a translucent image of a computer mouse, 
called the touch pointer, floats beneath your finger. The touch pointer has left and right 
mouse buttons that you can tap with your finger. You use the area beneath the buttons 
to drag the touch pointer. 
 
 

 

1.3.3 Windows XP  

1.3.3.1 Pen Usage 
Using the Pen as a Mouse 

You can use the pen the same way you use a mouse or touch pad with a notebook computer. Holding 
the pen near the display makes a small cursor appear. Moving the pen moves the cursor. 
 

Tapping on the screen once is the same as clicking with a mouse. A double-tap constitutes 
a double-click. 
 
Right-clicking with the pen is accomplished by holding the pen tip down on the screen until 
a red circle surrounds the pointer as illustrated to the right. Lifting the pen from here 
opens up the corresponding submenu.  
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Using the Pen as a Pen 

The native handwriting recognition software makes it easy to enter text into your applications with the 
pen. Some applications, such as Windows Journal, allow you to write with the pen directly into the 
application window. 
 

Tablet PC Input Panel 
When an application does not directly support pen input, you can use the Tablet PC Input Panel to 
enter text into your application. If you tap in an editable area, the Tablet PC Input Panel icon 
appears. Tapping the icon makes Input Panel appear. 
 
You can move the Input Panel tab by dragging it up or down along the edge of the screen. Then, when 
you tap it, the Input Panel opens at the same horizontal location on the screen that the tab appears. 
 
You can use the writing pad, the character pad, or the on-screen keyboard to enter text. The writing 
pad and the character pad convert your handwriting into typed text. The on-screen keyboard works 
just like a standard keyboard except that you enter text by tapping keys with your tablet pen. The 
following table describes the different choices for using the Input Panel.  
 

Input Panel Icons 

Icon Name Function 

 Writing Pad 
With the writing pad, you can write continuously as if you were writing on a 
lined piece of paper. 

 Character Pad 
The character pad converts your handwriting to typed text, one letter, number, 
or symbol at a time. 

 
On-screen 
Keyboard 

The on-screen keyboard is similar to a standard keyboard.  

 
The writing pad and character pad have a number pad, a symbol pad, and web quick keys to help you 
quickly and accurately enter these types of text. These quick keys are hidden when you start to write, 
but appear after you insert or delete your writing. 
 

Touch Usage 
One of the key advantages of your XT2 XFR is the ability to easily switch from pen input to touch 
input. Similar to how the pen works, tapping with your finger on the screen once is the same as 
clicking with a mouse. A double-tap constitutes a double-click. 
 
Right-clicking in Touch Mode is accomplished by holding your finger tip down on the screen until a red 
circle surrounds the pointer. This can be difficult to see as often times user's fingers cover the pointer. 
Lifting your finger from this point opens up the corresponding submenu.  
 

Tablet and Pen Settings 
Most of the settings for the tablet and pen are located in Control Panel under Tablet and Pen Settings. 
These are also accessed through Dell Control Point System Manager.  

1.4  XT2 XFR Settings 

1.4.1 Installation 
The N-trig Tablet Settings applet is built into the driver package. You can either install it directly from 
the ResourceCD or obtain the latest version from support.dell.com. Once the file has been extracted, 
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an InstallShield Wizard will walk you through the process of installing the software. The appearance of 
the N-trig icon is an indication of a successful installation. 

1.4.2 Windows™ XP vs. Windows Vista™  
There is only one major difference in the N-trig applet between XP and Vista. On the Digitizer Options 
tab, under the Input Mode section, there is no listing for Dual Mode on the XP version. Windows XP 
does allow use of both pen and touch but the seamless switching capability that Vista offers is not 
available. 

1.4.3 N-trig Applet 
The N-trig Tablet Settings applet is used to adjust several settings for the digitizer. Once the N-trig 
drivers are loaded, an icon appears in the system tray. 
 

 
 
Hovering over the icon with your pointer displays the firmware version number. Right-clicking the icon 
brings up the sub menu below. 
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Clicking on Properties opens up the N-trig Tablet Settings window. 
 

 
 
There are four tabs on the N-trig Tablet Settings window: 

• Digitizer Options 
• Interaction Options 
• Multi-Touch Gestures 
• About 

 

1.4.3.1 Digitizer Options Tab 
The Digitizer Options tab is used for the following: 

• Input mode selection  
• Touch tuning  
• Launching diagnostics  
• Restoring default settings 
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1.4.3.1.1  Input Mode Selection 
The N-trig applet has 4 operating modes: 
 
Pen Only — In this mode, the stylus is the only device that can be used as the input device with the 
N-trig digitizer. Changing from Pen Only mode to any other mode is done by clicking with an active 
input device on the N-trig Applet icon in the system tray. When the applet is open, select desired 
mode and press OK. 
 
Touch Only — In Touch Only mode, a single finger is the only input device that can be used with the 
N-trig digitizer. Using the stylus is not possible. It is important to note that only a single hand contact 
is allowed with the digitizer for proper execution. Changing Touch Only mode into any other mode is 
done by tapping the N-trig Applet icon in System Tray using a finger or other active input device and 
choosing the desired mode. Press OK to confirm. 
 
Auto Mode — The N-Trig digitizer is capable of detecting a stylus as well as finger touch. The purpose 
of Auto Mode is to allow the user intuitive toggling between the Pen Only or Touch Only modes. The 
default input device for Auto Mode is the stylus as long as it is in range of the tablet screen (hovering 
in proximity or in contact). A basic principle in Auto Mode is that stylus detection in the digitizer 
proximity would turn the digitizer into Pen Only mode as an overriding priority. A double-tap finger 
gesture on the screen (similar in style to a mouse double-click) will switch the digitizer from Pen Only 
mode to Touch Only mode. The system will remain in Touch Only mode as long as the stylus is out of 
range. Once the stylus is detected in range the system will automatically switch to Pen Only mode. 
 
Dual Mode (Vista Only) — Dual Mode is a unique operational mode that is functional only while 
using the Microsoft Vista operating system. In this mode, the OS switches automatically between the 
available pointing device according to its internal priority and attributes. 
 

1.4.3.1.2  Touch Tuning 
 
If you believe that the XT2 XFR's finger detection 
function is not working properly, a recalibration of the 
touch feature may be in order. To accomplish this, 
click the Reset button and then follow the on-screen 
prompts.  

 CAUTION: Do NOT touch the screen while 
touch reset is in progress.  

A message indicating success or failure appears once 
the reset routine completes. If the result is failure, try 
running the diagnostics.  
 

 

1.4.3.1.3  Launching Diagnostics 
Running the diagnostics will help determine the functionality of the digitizer. Start by clicking the 
Troubleshoot button. Pressing the Self Test button on the subsequent pop-up window starts the 
diagnostics. 
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After the test is complete, the results are displayed as illustrated below. 
 

 
 
 
Use this table to define the result codes. 

Digitizer Self Test Result Codes 

Code Test Error Details Symptoms 

7 
A-trigs 
connectivity 

Digitizer analog 
processor fail 

Digitizer is unable to initialize or read samples from analog 
processor. No pen or touch position is reported. 

11 Stylus excitation No pen excitation 
Signals received during the stylus excitation test are below 
certain limit. Pen may be not functional or detected in tip 
only. 

14 
Sensor Antenna 
disconnects 

Digitizer grid 
disconnect 

There are disconnected lines. Pen or touch may be 
malfunctioning in a specific physical display area. 

15 
Sensor Antenna 
shorts 

Digitizer grid 
shortcut 

There are shorted lines. Pen or touch may be malfunctioning 
in a specific physical display area. 

18 
Channel 
imbalance 

Digitizer channel 
degraded 

There is an unbalanced channel. Pen or touch may be 
malfunctioning in a specific physical display area. 

19 
Capacitor 
calibration 

Digitizer 
calibration 
degraded 

The calibration capacitor in a certain channel is set to 
minimal or maximum value. Pen or touch may be 
malfunctioning in a specific physical display area. 

47 
Internal Firmware 
Error 

Internal 
Firmware Error 

Firmware resource problem in executing diagnostics. 
Diagnostics tool is not functional. 

48 
Critical 
Malfunction 

Device Error Critical malfunction was detected, test cannot continue. 
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49 
Host Timeout 
Error 

Host Timeout 
Error 

Host communication or resources problem in executing 
diagnostics. 

50 
Capacitor 
Calibration 
Required 

Hardware 
calibration is 
required 

Hardware calibration is required to gain maximum 
performance. 

 

1.4.3.2 Interaction Options Tab 
The Interaction Options tab controls the visual and sound effects that can modify the user 
experience while operating the system's various modes. 

1.4.3.2.1  Auto Mode Switching Graphical Indicator 
This section enables you to select a .gif file (image) to be displayed whenever an auto mode switching 
event is detected. You can select the event that will cause the graphical indicator to appear: 
 

• Pen  Touch: Pen is detected after finger usage.  
• Touch  Pen: Touch is detected after pen usage. 

1.4.3.2.2  Sound Feedback 
This section enables you to select which .wav file (sound) will be played when the finger touches the 
screen. The sound can be tested using the play button. One can enable/disable this functionality using 
the specified radio button.  

1.4.3.3 Multi-Touch Gestures Tab 

1.4.3.3.1  Gestures 
Gestures are expressions made while touching the screen of your Tablet PC with two fingers. They are 
interpreted as user commands to the operating system or active application software. When the 
operating system recognizes a gesture, an icon confirming the gesture appears on the screen. This 
multi-touch update includes three gestures: a scroll gesture, a zoom gesture, and a two-finger double-
tap gesture. Gesture features and descriptive icons shown herein are sourced by N-trig.  
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Scroll Gesture 
 
Placing two fingers on the screen and moving them horizontally or vertically generates 
scrolling in the direction of movement: right, left, up, or down. 

 

 

Zoom Gesture 

 
Touching the screen with two fingers and moving them together or 
apart generates a zoom-in or zoom-out command to the screen. 

 

Two-Fingers Double-Tap Gesture 
Tapping the screen twice with two fingers sends an operating system command that 
you can configure. It can be used to perform actions, such as turning the display off 
and disabling touch gestures (default), or run an executable program, such as one 
that opens Internet Explorer. 
 
 
 

Sensitivity Setup 
To adjust the sensitivity for the two-finger gestures, double-click the N-trig icon ( ) in the system 
tray, and tap the Multi-Touch Gestures tab. Set the sliders for each gesture as desired. 
 

 
 

1.4.3.4 About Tab 
 
The About tab is used to find information such as the driver version and firmware revision numbers. 
The firmware revision number can also be obtained by hovering your pointer over the N-trig Tablet 
Settings icon in the system tray. 
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1.5 XT2 XFR Pen 

 
Your XT2 XFR uses a specifically designed electrostatic pen or stylus for use in tablet PC mode. 
Instead of relying on battery power, the energy source for the stylus is magnetic energy produced by 
the excitation coil built into the digitizer itself. The signal from the coil is picked up by the stylus and 
triggers the stylus to transmit an electric field. 
 
The transmitted electric field is sensed by a matrix of conductive lines, accurate stylus position 
determined using the low amplitude signals received on the vertical and horizontal conductors, and an 
appropriate signal is transferred to the digitizer's on-board processor.  
 
Tips come in one color type, black. The black tips present a "harder" writing feel.  The system ships 
with a total of two black tips. These tips are easily replaced by using the pen-tip removal tool which 
looks similar to an oversized pair of tweezers. This tool also ships with the XT2 XFR. 
 

 NOTE: In the event of a suspected digitizer failure, the pen tip should be examined. If the tip is 
damaged it needs to be replaced. This will oftentimes remedy the problem with the digitizer.  

 

1.5.1 Calibrating the Pen 
The pen can function at the default calibration or at a calibration set by you or by another user. It is 
recommended that you use the pen only while it is calibrated to your personal calibration settings. 
Calibration optimizes pen performance for each user. 
 

 
To calibrate the pen: 
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1. Open Dell Control Point.  
2. Click System  Tablet Settings.  
3. On the Dell Tablet Settings window, click Pen & Input then click Calibrate.  
4. Follow the instructions on the screen. The calibration markers are displayed on the screen as 

plus signs (+). Tap the pen in the exact center of each of the calibration markers. 
 

 
 

NOTE: Be sure to calibrate the pen for use in both portrait and landscape display orientations.  

1.5.2 Troubleshooting 
The pen is the first component to be investigated in the event of a suspected problem with the 
digitizer. Verify the tip is in good shape (free of chips, excessive wear, etc.) by closely examining it. If 
there is any doubt, you should change out the tip with a new one or one that is known to be in good 
condition. 
 
You should also verify that the touch capabilities are not affected. Switch to touch mode and see if the 
problem still exists. If there are no symptoms present while in touch mode, the pen tip is the most 
likely suspect. If the problem does persist in touch mode you should run diagnostics and take the 
necessary steps depending on the results.  
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1.6 Application Matrix 

The following matrix shows the gestures supported by the operating system and specific application 
software packages. Other applications may also respond to these gestures.  
 

Operating System Microsoft™ Windows Vista™  Microsoft Windows™ XP 

Application 
Family 

Application 
Name 

Pinch/Zoom 
Horizontal 

Scroll 
Vertical 
Scroll 

Pinch/Zoom 
Horizontal 

Scroll 
Vertical 
Scroll 

Windows 

Explorer Yes Yes Yes No Yes Yes 

Photo 
Gallery 

Yes Yes Yes No No No 

Windows 
Live 

Photo 
Gallery 

Yes Yes Yes No No No 

Virtual Earth   No No No No No No 

Microsoft 
Office 2007 

Outlook® Yes Yes No Yes Yes No 

Word Yes Yes Yes Yes Yes No 

Excel® Yes Yes Yes Yes Yes No 

Power 
Point® 

Yes Yes Yes Yes Yes Yes 

One Note® Yes Yes Yes Yes Yes No 

Picture 
Manager 

Yes Yes Yes Yes Yes Yes 

Microsoft 
Office 2003 

Outlook® Yes Yes Yes Yes Yes Yes 

Word Yes Yes Yes Yes Yes Yes 

Excel 
® 

Yes Yes Yes Yes Yes Yes 

Power 
Point® 

Yes Yes Yes Yes Yes Yes 

One Note® Yes Yes Yes Yes Yes Yes 

Picture 
Manager 

Yes Yes Yes Yes Yes Yes 

 
 
 
 
 
 
 
 
 
 
 
 
 

2 Working on Your XT2 XFR 
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2.1  Before Working Inside Your XT2 XFR 

Use the following safety guidelines to help protect your XT2 XFR from potential damage and to help to 
ensure your personal safety. Unless otherwise noted, each procedure included in this document 
assumes that the following conditions exist: 
 

• You have performed the steps in Working on Your XT2 XFR. 
• You have read the safety information that shipped with your XT2 XFR.  
• A component can be replaced or--if purchased separately--installed by performing the removal 

procedure in reverse order. 
 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance. 

 CAUTION: Only a certified service technician should perform repairs on your XT2 XFR. 
Damage due to servicing that is not authorized by Dell is not covered by your 
warranty. 

 CAUTION: To avoid electrostatic discharge, ground yourself by using a wrist grounding 
strap or by periodically touching an unpainted metal surface, such as a connector on 
the back of the computer. 

 CAUTION: Handle components and cards with care. Do not touch the components or 
contacts on a card. Hold a card by its edges or by its metal mounting bracket. Hold a 
component such as a processor by its edges, not by its pins. 

 CAUTION: When you disconnect a cable, pull on its connector or on its pull-tab, not on 
the cable itself. Some cables have connectors with locking tabs; if you are 
disconnecting this type of cable, press in on the locking tabs before you disconnect the 
cable. As you pull connectors apart, keep them evenly aligned to avoid bending any 
connector pins. Also, before you connect a cable, ensure that both connectors are 
correctly oriented and aligned.  

 NOTE: The color of your XT2 XFR and certain components may appear differently than shown in 
this document.  

To avoid damaging your XT2 XFR, perform the following steps before you begin working inside the XT2 
XFR.  
 

1. Ensure that your work surface is flat and clean to prevent the XT2 XFR cover from being 
scratched.  

2. Turn off your XT2 XFR (see Turning Off Your XT2 XFR).  
3. If the XT2 XFR is connected to a docking device (docked) such as the optional Media Base or 

Battery Slice, undock it.  
 

 CAUTION: To disconnect a network cable, first unplug the cable from your XT2 XFR and 
then unplug the cable from the network device. 

4. Disconnect all network cables from the XT2 XFR.  
5. Disconnect your XT2 XFR and all attached devices from their electrical outlets.  
6. Close the display and turn the XT2 XFR upside-down on a flat work surface.  

 

 CAUTION: To avoid damaging the system board, you must remove the main battery 
before you service the XT2 XFR.  

7. Remove the main battery (see Removing the Main Battery).  
8. Turn the XT2 XFR top-side up.  
9. Open the display. 
10. Press the power button to ground the system board.  
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 CAUTION: To guard against electrical shock, always unplug your XT2 XFR from the 
electrical outlet before opening the display. 

 CAUTION: Before touching anything inside your XT2 XFR, ground yourself by touching 
an unpainted metal surface, such as the metal at the back of the XT2 XFR. While you 
work, periodically touch an unpainted metal surface to dissipate static electricity, 
which could harm internal components. 

11.  Remove any installed ExpressCards or Smart Cards from the appropriate slots. 
12. Remove the hard drive (see Removing the Hard Drive). 

2.2 Recommended Tools 

The procedures in this document may require the following tools: 
 

• Small flat-blade screwdriver  
• #0 Phillips screwdriver  
• #1 Phillips screwdriver  
• Small plastic scribe  
• Flash BIOS update program CD 

2.3  Turning Off Your XT2 XFR 

 CAUTION: To avoid losing data, save and close all open files and exit all open programs 
before you turn off your XT2 XFR. 
 

1. Shut down the operating system:  
 

• In Windows Vista: 

       Click Start , then click the arrow in the lower-right corner of the Start menu as shown 
       below, and then click Shut Down. 
 

 
 

• In Windows XP:  
 
       Click Start Turn Off Computer Turn Off.  
 
       The XT2 XFR turns off after the operating system shutdown process is complete. 
 

2. Ensure that the XT2 XFR and all attached devices are turned off. If your XT2 XFR and attached 
devices did not automatically turn off when you shut down your operating system, press and 
hold the power button for about 4 seconds to turn them off.  

 
 
 

2.4  After Working Inside Your XT2 XFR 
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After you complete any replacement procedure, ensure you connect any external devices, cards, and 
cables before turning on your computer. 
 

 CAUTION: To avoid damage to the XT2 XFR, use only the battery designed for this 
particular Dell computer. Do not use batteries designed for other Dell computers.  

1. Connect any external devices, such as a port replicator, battery slice, or media base, and 
replace any cards, such as an ExpressCard.  

2. Connect any telephone or network cables to your XT2 XFR.  
 

 CAUTION: To connect a network cable, first plug the cable into the network device and 
then plug it into the computer. 

3. Replace the main battery.  
4. Connect your XT2 XFR and all attached devices to their electrical outlets.  
5. Turn on your XT2 XFR.  

 
 
 

3 Screw Chart 
 

Chassis Location Screw Part # Qty 

1 USB/1394 DOOR       

    hinge assy screw-M3 x 3 21106-03 2 

    Latch screw-M1.2 40621 1 

    door to chassis mouting screw 21106-00 4 

2 IO/AUDIO DOOR       

    hinge assy screw-M3 x 3 21106-03 3 

    Latch screw-M1.2 40621 1 

    door to chassis mouting screw 21106-00 6 

3 IO/VGA DOOR       

    hinge assy screw-M3 x 3 21106-03 2 

    Latch screw-M1.2 40621 1 

    door to chassis mouting screw 21106-00 4 

4 POWER DOOR       

    hinge assy screw-M3 x 3 21106-03 1 

    Latch screw-M1.2 40621 1 

    door to chassis mouting screw 21106-00 2 

5 RF PASS THRU       

  M2 x 3 21106-00 2 

6 STYLUS BAY       

  Self tapping screw 40426 1 

7 SNIFFER ASSEMBLY    

  M2 x 3 21106-00 2 

8 SYSTEM BOARD       

  M2.5 x 5 21106-01 1 

    M2.5 x 8 21106-02 1 
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9 WIFI ASSEMBLY    

    custom   1 

10 HINGE PLATE TO CHASSIS    

    M2.5 x 5 21106-01 2 

Palm Rest         

1 KEYBOARD DOOR    

    M2 x 3 21106-00 2 

2 TOUCH PAD ASSEMBLY    

    M2 x 3 21106-00 4 

3 USB HUB BOARD    

    M2 x 3 21106-00 2 

4 
BLUETOOTH MODULE 
(option) 

   

    M2 x 3 21106-00 1 

5 KEYBOARD    

    M2 x 3 21106-00 2 

6 Upper Palm Rest Screw    

    CSK screw-M2x 5 40628 1 

LCD inner- Bezel         

1 FPR board    

    M2 x 3 21106-00 1 

LCD Outer         

1 Rocker Switch Assy    

  custom Thread Forming 3 

2 Antenna bracket    

    M2 x 3 21106-00 4 

LCD ASSY         

1 LCD mouting screws-PCB    

    custom csk 40319 3 

2 Hinge Moutning screws    

    M2.5 x 5 21106-01 4 

3 ID Plate    

    M2.5 x 5 21106-01 4 

4 
LCD inner and Outer Assy 
screws    

   M2.5 x 8 21106-02 8 

   front top side M2.5 x 7 40630 4 

5 Hinge Cover screw    

    M2.5 x 5 21106-01 1 

Base to LCD          

1 hinge mouting base screw    

    M3 x 3 40500 4 

2 Cable Clamp screws    
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  custom Thread Forming  

Base to Palm rest         

1 under the battery area    

    M2.5 x 5 21106-01 7 

2 under the battery area    

    M2.5 x 8 21106-02 1 

3 bottom side screws    

    M2.5 x 8 21106-02 9 

Battery Module         

1 Battery module assy    

    M2 x 3 21106-00 4 

KEYPAD / HINGE 
COVER         

1 Captive screw-M2    

    custom 40190 4 

Dimms Door         

1 Captive screw-M2    

    custom 40190 4 

Latch Palm Rest         

1 shoulder screw, Captive    

    custom 40301 2 
 

4 Adding and Replacing Parts  

4.1 Main Battery 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

 

 

http://www.dell.com/regulatory_compliance�
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4.1.1 Removing the Main Battery 
1. Follow the procedures in Before Working Inside Your XT2 XFR. 
2. Slide the two battery-bay latch releases on the bottom of the XT2 XFR outward to each side. 

 

 
3. Slide the battery out of the battery bay. Lift slightly using the latches to release the back 

edge. 

 
 
 

4. Remove the battery from the XT2 XFR. 
 

4.1.2 Removing the Battery from the Battery Door 
 

1. Follow the procedures in Before Working Inside Your XT2 XFR. 
2. Remove the battery from the XT2 XFR before continuing. 
3. Loosen the four captive screws on the front edge of the battery door.  This releases the 

battery bracket. 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 29 of 94                                               Version A00-01 

 
 

4. Rotate the door up to remove the battery. 
 

 
 

5. Remove the battery. 
 

4.1.3 Installing the Battery into the Battery Door 
 

1. Place the bracket onto the battery. 
 

 

2. Slide the battery onto the battery door and align the tabs on the battery with the door tabs. 
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3. Hold the bracket down and tighten the four captive screws. 

 

4.2 Hinge Cover 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.2.1 Removing the Hinge Cover 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Loosen the four captive screws securing the hinge cover in place. 

 

4. Use your fingers to release the rest of the hinge cover by pulling up slightly and remove from 
the XT2 XFR. 
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4.3 Keyboard 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.3.1 Removing the Keyboard 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Before performing this step, follow the instructions in removing the battery section.  
3. Perform the instructions on removing the hinge cover section. 
4. Remove the two screws securing the keyboard to the XT2 XFR. 
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5. Gently slide the keyboard towards the display. 

 

6. Remove the two screws (M2 x 3-mm) securing the connector door to the palm rest. 
7. Lift and remove the connector door. 
8. Release the zif connector for the touchpad cable. 
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7. Disconnect the touch pad cable. 

 

8. Release the zif connector for the keyboard cable. 
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9. Lift using the blue pull tab on the keyboard cable and disconnect the keyboard cable from the 
system board. 

10. Remove the keyboard from the XT2 XFR. 

 

4.4 Memory and Mini-Card Cover 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance. 

4.4.1  Removing the Memory and Mini-Card Cover 

 
 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Loosen the two captive screws on the memory and mini-card cover. 

http://www.dell.com/regulatory_compliance�
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4. Lift the cover up from the left side using the grip tab. 

 

5. Lift the cover while sliding to the left, and remove from the XT2 XFR. 
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4.5 Memory 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.5.1 Removing a Memory Module 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery before continuing. 
3. Remove the memory and mini-card cover before continuing.  
4. Use your fingers to gently pry the retaining clips away from the memory module. 

 

5. Remove the memory module from the XT2 XFR at an angle. 

http://www.dell.com/regulatory_compliance�
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4.6 Hard Drive 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.6.1  Removing the Hard Drive 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Slide the hard drive towards front edge to disconnect from the system board and unlock the 

housing from the chassis. 
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4. Lift the handle to remove the hard drive from the XT2 XFR. 
 

 
 

4.7 Mini-Card 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

Handle 
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4.7.1  Removing the Mini-Card 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR.  
3. Remove the memory and mini-card cover before continuing. 
4. Depending on the type of wireless adapter installed, disconnect either two or three antenna 

cables from the mini-card.   Each mini-card will have a label for the wire to be connected or 
disconnected from the adapter.  WWAN, WLAN and WPAN mini-cards all have similar labeling. 

 

 

 

 NOTE: There are five cables located under the memory door.  Two enter the bay from the left 
side, three enter from the back center location.  The table below explains where each cable 
would connect to for WLAN and WWAN devices.  Most new WLAN and WWAN mini-cards 
available today have icons on their label that tells you which cable to connect to which antenna 
port. 
 

1 BLACK (left side) – Connects to black labeled terminal on WLAN adapters 
2 GREY (left side) – Connects to grey terminal on WWAN adapters 
3 WHITE (center) – Connects to white terminal on WLAN adapters 
4 WHITE/GREY (center) – Connects to white terminal on WWAN adapters 
5 GREY (center) – Connects to grey terminal on WLAN adapters (If adapter is A/G/N capable) 
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5. Use your finger to gently pry the retaining clips back and release the mini-card. 

 

6. Remove the mini-card from the XT2 XFR at an angle. 

 

 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 41 of 94                                               Version A00-01 

 

4.8 Internal Card With Bluetooth® Wireless 
Technology 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.8.1 Removing the Internal Card With Bluetooth 
Wireless Technology 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery before continuing. 
3. Disconnect the Bluetooth cable from the Bluetooth adapter. 

 

4. Loosen the screw on the Bluetooth assembly. 
5. Carefully lift the Bluetooth assembly out of the XT2 XFR. 
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6. Remove the Bluetooth assembly from the XT2 XFR. 
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4.9 Palm Rest 

 WARNING: Before working inside your XT2 XFR, read the safety information that shipped with 
your XT2 XFR. For additional safety best practices information, see the Regulatory Compliance 
Homepage at www.dell.com/regulatory_compliance.  

4.9.1 Removing the Palm Rest 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery before continuing. 
3. Remove the hard drive before continuing. 
4. Remove the memory and mini-card cover  before continuing.  
5. Disconnect any antenna cables from the WWAN/WLAN adapters in the XT2 XFR. 
6. Remove the seventeen (17) screws (7 – 2.5 x 5-mm and 10 - 2.5 x 8-mm) securing the palm 

rest from the bottom of the XT2 XFR. 
7. Release the two (2) locking tabs by pressing each toward the corner edge slightly and pushing 

down to disengage the tabs from the chassis. 

 

8. Flip the unit over and remove the hinge cover from the XT2 XFR. 
9. Remove the keyboard from the XT2 XFR.  
10. Rotate the LCD 90 degrees to allow access to the front and rear mounting plate screws. 

Remove the 2 screws for the Hinge Cap and remove the hinge cap from the rear of the 
system, then remove the 2 screws in the LCD Hinge securing the display assembly to the 
chassis. 

11. Remove two cable clamp to base screws and lift the clamp out of the XT2 XFR.  
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12. Lay the display assembly behind the chassis. 
13. Gently lift the palm rest, moving the door opening over to the right slightly and disconnect the 

touchpad cable. 

 

14. Lift the palmrest from the left side slightly and tilt the palm rest up towards the right to 
disconnect the LCD to USB hub board and USB hub board to system board connector. 
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15. Remove the palm rest from the XT2 XFR. 

 

 

 

 

 

4.9.2 Installing the Palm Rest 

1. Insert the cable clamp over the LCD cables and secure with the cable clamp to base screws. 

 CAUTION: Make sure the cable clamp is set properly over the cable gasket and the 
cable gasket is secure before proceeding.  Failure to perform this step properly could 
cause an inlet for moisture into the system. 

2. Set the palm rest onto the right side and tilt the palm rest up connect the USB Hub board to 
system board cable (ribbon cable).  Then connect the LCD to USB Hub board cable. 
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3. Ensure the ribbon cable for the touch pad can be seen through the palm rest door, then place 
the palm rest over the chassis so the view through the door is over the touchpad connector.  
Insert the touch pad cable into the connector and close the lock tab. 

 

4. Lift the palm rest slightly and set it into position over the edge gaskets and press on the palm 
rest front edge to lock the palm rest into place. 

5. Install the screw on the right side of the keyboard valley. 
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6. With the LCD bracket rotated 90 degrees, set the display onto the chassis and align the 
bracket guide pins.   

 

7. Install the back hinge cap and tighten the two screws securing the cover. 
8. Install the front two screws securing the display to the chassis.  Rotate the display to 

notebook mode before continuing. 
9. Install the keyboard.  (see Keyboard chapter for reference) 
10. Install the hinge cover. (see Hinge Cover chapter for reference) 
11. Turn the system over so the bottom side is facing up. 
12. Install the seventeen (17) screws (7 – 2.5 x 5-mm and 10 - 2.5 x 8-mm) securing the palm 

rest from the bottom of the XT2 XFR. 

Bracket guide pin 
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13. Install the WLAN/WWAN mini-cards. (See mini-card chapter for reference) 
14. Install the memory module. (See memory chapter for reference) 
15. Install the mini-card and memory door. (See memory cover chapter for reference) 
16. Install the hard drive. (See hard drive chapter for reference) 
17. Install the battery. (See battery chapter for reference) 

4.10 Coin-Cell Battery 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.10.1 Removing the Coin-Cell Battery 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Disconnect the coin-cell battery from the system board and remove from the XT2 XFR 
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4.10.2 Installing the Coin-Cell Battery 

1. Connect the coin-cell battery to the system board. 
2. Place the tape side of the battery to the left of the chassis pad directly in front of the USB 

connector location. DO NOT place battery on chassis pad. 

 

3. Follow the procedures for Installing the palm rest. 

 

4.11 USB Interface Board 

4.11.1 Removing the USB Interface Board 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance. 

 

http://www.dell.com/regulatory_compliance�
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1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Flip the palm rest over and remove the protective Mylar tape (covering the USB hub board 

assembly), and save, as this will be replaced later during installation. 
4. Disconnect the Smartcard reader cable, the Bluetooth cable and the system board cable from 

the ZIF connectors on the USB Interface board. 
5. Remove the 4 screws holding the USB interface board to the palm rest. 

  

4.12 Stylus Bay 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.12.1 Removing the Stylus Bay 
1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Disconnect the stylus bay connector from the system board. 
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4. Loosen and remove the screw holding the stylus bay housing to the chassis. 
 
 

 
 
 

5. Unthread the cable and connector for the stylus bay. 
6. Remove the Stylus Bay from the bottom chassis by lifting up. Being careful not to damage the 

grommet that seals to the base.  
 
 

4.12.2 Installing the Stylus Bay 
 

1. Start by threading the cable and connector through the opening in the chassis. 
2. Set the grommet surrounding the cable in the opening to produce a seal. 
3. Insert the stylus bay into the chassis being careful with the gaskets around the bay. 
4. Insert and tighten the self tapping screw. 

4.13 Speaker 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  
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4.13.1 Removing the Speaker 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Disconnect the speaker cable from the system board. 

 

4. Remove the speaker assembly from the XT2 XFR. 

 

 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 53 of 94                                               Version A00-01 

4.14 WiFi Sniffer Assembly 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

 

4.14.1 WiFi  Sniffer Assembly Removal 
 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in Removing the palm rest before continuing. 
3. Loosen and remove the two screws holding the WiFi sniffer assembly chassis. 

 

  
 

4. Carefully remove the WiFi sniffer assembly from the bottom chassis by rotating slightly. 
 

4.14.2 Wifi Sniffer Assembly Installation 
 

1. Install the sniffer switch assembly into the chassis.  On installation, the sniffer switch needs to 
be aligned with the metal bracket for the external switch. (see image below) 

 

 
 

2. Install the two screws (2 x 3-mm) holding the sniffer bracket to the chassis. 
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4.15 Sniffer Button and Wifi Switch 
 

1. Remove the sniffer button by inserting a plastic scribe on the top corner and lightly pressing 
down to relase the seal. 

 

  
2. Remove the button. 

 

4.15.1 Installing the Wifi sniffer button 
 

1. Place the rubber sniffer button over the hole and gently press while rolling your finger over the 
button.  This is a self sealing button. 

 

 
 

2. Verify the button is sealed by sliding your finger over it. 
 
 
 
 

4.15.2 Installing the Wifi on/off switch 
 

1. Follow the procedures in WiFi Sniffer Assembly Removal before continuing. 
2. Place a scribe or flathead screwdriver at a position that allows the switch to be inserted into 

the center hole of the metal bracket and hold firmly in place. 
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3. Press the switches clips through the hole in the bracket until it locks in place.   
 

 
 
 

 NOTE: It may help to hold the tool and bracket in place with the flathead screwdriver and set the 
switch in place then use your index finger to hold the upper part of the bracket while pressing the 
switch into place with your thumb. 

 
4. Perform the steps for Installing the WiFi Sniffer Assembly. 
5. To complete perform the steps for Installing the Palm Rest. 

 
 
 
 
 
 

Set flat scribe here. 
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4.16 System Board 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.16.1 Removing the System Board 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. From the inside of the XT2 XFR, disconnect the display cable from the system board. 
4. Remove the coin-cell battery from the XT2 XFR.  
5. Disconnect the speaker cable from the system board. 
6. Disconnect the Stylus bay connector from the system board. 
7. Disconnect the video connector from the system board. 
8. Remove the sniffer switch cable from the system board. 
9. Remove the two screws securing the system board to the bottom chassis and white plastic 

bracket. 
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1 Speaker connection 2 Stylus connection 

3 Coin-cell battery connection 4 WiFi sniffer connection 

5 System board screw (2.5 x 5-mm) 6 System board screw at bracket (2.5 x 8-mm) 

10. Carefully lift the gasket surround from the fan housing area and lift the gasket from over the 
video/antenna cable socket. 

  

11. Lift the system board up and remove from the XT2 XFR. 

1 

2 

3 

4 

5
  

6
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4.16.2 Installing the System Board 

1. Examine the system board to make sure there are nine (9) insulation pads set around the 
grounding clips on the palmrest side of the system board, and one (1) on the processor side of 
the system board near the docking connector.   

  

 

2. Place the system board into the chassis and seat the fan cable grommet into the grommet 
channel. 

3. Install the screws (1 – 2.5 x 5-mm), (1- 2.5 x 8-mm with bracket) securing the system board 
to the chassis. 

 

1 Speaker connection 2 Stylus connection 

3 Coin-cell battery connection 4 WiFi sniffer connection 

1 

2 

3 

4 

5
  

6
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5 System board screw (2.5 x 5-mm) 6 System board screw at bracket (2.5 x 8-mm) 

4. Connect the sniffer switch cable to the system board. 
5. Connect the stylus bay cable to the system board. 
6. Connect the speaker to the system board. 
7. Connect the video cable to the system board. 
8. Connect the coin-cell battery to the system board. 
9. Place the fan bay gasket back into the channel and press down as it’s laid over to ensure a 

proper fit. 

 CAUTION: Make sure the gasket is set properly over the chassis and around the heat-
sink and fan bay before proceeding.  Failure to perform this step properly could cause 
an inlet for moisture into the system. 

10. Complete the assembly by following instructions for Installing the Palm Rest.  

 

4.17 Heat Sink and Fan Assembly 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

 

4.17.1 Removing the Heat Sink and Fan Assembly 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Follow the procedures in Removing the system board before continuing. 
4. Disconnect the fan cable from the system board connector, then flip over the system board. 
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5. Loosen the four captive screws on the heat sink. 

 

16. Remove the top section of the heat sink assembly from the system board, then turn over the 
system board again. 

 

 

17. Remove the bottom section of the heat sink assembly.  
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 NOTE: Make sure the insulator is attached to the system board prior to installation of the heat 
sink assembly.  If this insulator is missing a replacement system board should be ordered.  

 

4.18 Display Assembly 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

http://www.dell.com/regulatory_compliance�
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4.18.1 Removing the Display Assembly 

 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in Removing the palm rest before continuing. 
3. From the inside of the XT2 XFR, disconnect the display cable from the system board. 
4. Carefully lift the gasket surround from the fan housing area and lift the gasket from over the 

video/antenna cable socket. 

  

 

 WARNING: Do NOT cut or remove the gasket material as this will cause the unit to not 
seal against water intrusion. 

5. Follow the procedures in Removing the system board before continuing. 
6. Remove the rear two Dock Door Screws along with the side screw and lightly loosen the front 

2 screws to allow the cables to pull out of the retention tab on the dock door bracket.  
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7. Remove the two (M2 x 3-mm) screws holding the RF Passthru board to the chassis and lift the 
RF passthru board up. 

 

8.  Disconnect the back Black/Grey, Red, and Black antenna cables from the RF Passthru board. 
9. Lift the cables for the display assembly out of the chassis area and remove the display 

assembly. 

4.18.2 Installing the Display Assembly 

1. Set the display assembly behind the system and pull all cables to align with the center of the 
chassis. 

2. The black/grey, red, and black cables with the barrel connector on the ends connect onto the 
back side of the RF Passthru board. The RF Passthru board is labeled to assist with connecting 
the cables to the appropriate locations. 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 64 of 94                                               Version A00-01 

 

ID PCB Reference Wiring Color 
1 WWAN – Back Black / Grey 
2 GPS – Back Red 
3 WLAN – Back Black 
4 WWAN – Front Grey 
5 WLAN - Front Black 

 

  

3. Route the three cables under the tab for the docking door bracket, then install and tighten the 
five (M2 x 3-mm) screws for the docking door bracket. 

4. Place the RF Passthru board into place and tighten the two screws (M2 x 3-mm) securing it to 
the chassis. 

5. Route the black and grey cable from the front end of the RF Passthru so they sit under the 
retention tab and lay within the memory door opening. 

1 2 3 

4 5 
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6. Set the three antenna cables from the display assembly within the memory door opening. 
7. Place the grommet surrounding the cables into the grommet chamber.  Be sure the grommet 

is seated properly and hold in place. 

 

8. Insert the cable bracket and install the two screws securing the bracket, cables and grommet 
in place.  Release the grommet once this has been completed. 

 

9. Perform the steps for Installing the system board before continuing. 
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10. Complete the assembly by performing Installing the palm rest. 

 

4.19 RF Passthru 

4.19.1 Removing the RF Passthru Board 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Follow the procedures in removing the palm rest before continuing. 
3. Follow the procedures in Removing the system board before continuing. 
4. Remove the two (2.5 x 5-mm) screws holding the RF Passthru board onto the bottom chassis. 

 

5. Remove the WWAN and WLAN RF Cables from the retaining tab. 
6. Lift the RF Passthru board straight up to remove. 

4.19.2 Installing the RF Passthru Board 

1. Connect the Black/Grey, Red and Black antenna cables from the Display assembly to the RF 
Passthru board.  The RF Passthru board barrel connectors are labeled for each cable. 
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ID PCB Reference Wiring Color 
1 WWAN – Back Black / Grey 
2 GPS – Back Red 
3 WLAN – Back Black 
4 WWAN – Front Grey 
5 WLAN - Front Black 

2. Set the RF Passthru board on the chassis, insert and tighten the two (2 x 3-mm) screws. 
3. Connect the grey and black mini-card cables into the barrel connectors on the opposite side 

and run them under the retainer tab. 

4.20 Rocker Switch 

4.20.1 Remove the Rocker Switch 
 

1. Remove the screw (M2 x 3-mm) from the center of the rocker switch. 
2. Pull the rocker switch with your finger until it disengages from the rocker pin. 

 

4.20.2 Install the Rocker Switch 
 

1. Insert the rocker switch onto the rocker pin. 
2. Secure the screw holding the rocker switch to the pin. 

 

1 2 3 

4 5 
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4.21 Doors 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.21.1 Removing the USB/1394 Door 

 

  

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the four (2.5 x 5-mm) screws from the door hinge connected to the bottom chassis. 
3. Rotate the pull tab to release the lock and open the door to remove. 

4.21.2 Removing the VGA/RJ45/USB Door 
 

  

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the four (2.5 x 5-mm) screws from the door hinge connected to the bottom chassis. 
3. Rotate the pull tab to release the lock and open the door to remove. 
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4.21.3 Removing the Power Door 

  

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the two(2.5 x 5-mm) screws from the door hinge connected to the bottom chassis. 
3. Rotate the pull tab to release the lock and open the door to remove. 

4.21.4 Removing the Audio/Card Socket Door 

  

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the two(2.5 x 5-mm) screws from the door hinge connected to the bottom chassis. 
3. Rotate the pull tab to release the lock and open the door to remove. 

4.22 USB Module Bay Cover 
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 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.22.1 Removing the USB Module Cover 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Unlock the cover from the LCD bezel.  
4. Remove the cover from the Hot Swappable Module bay. 

4.23 GPS Module (OPTIONAL) 

Unlock Position 
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 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.23.1 Removing the GPS Module 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Unlock the GPS from the LCD bezel.  
4. Remove the GPS module from the Hot Swappable Module bay. 

 

 

 

 

 

 

 

 

Unlock Position 
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4.24 Camera Module (OPTIONAL) 

 

 WARNING: Before working inside your XT2 XFR, read the safety information that 
shipped with your XT2 XFR. For additional safety best practices information, see the 
Regulatory Compliance Homepage at www.dell.com/regulatory_compliance.  

4.24.1 Removing the Camera Module 

1. Follow the procedures in Before Working Inside Your XT2 XFR.  
2. Remove the battery from the XT2 XFR. 
3. Unlock the camera from the LCD bezel.  
4. Remove the GPS module from the Hot Swappable Module Bay. 

 

 

 

 

 

 

Unlock Position 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 73 of 94                                               Version A00-01 

5 Specifications 
 

 NOTE: Offerings may vary by region. For more information regarding the configuration of 

your XT2 XFR, click Start (or Start in Windows XP)Help and Support, and then select 
the option to view information about your XT2 XFR. 

 

Processors  
Intel® Core™2 Duo ULV processor up to SU9600 (1.6GHz, 800 MHz FSB, 3 MB L2 
Cache) with vPro technology 

Chipset  Intel® Small Form Factor Montevina Chipset 

Graphics  Intel Integrated Graphics Media Accelerator 4500MHD 

Audio  1 Speaker, stereo headphone and line out jack, Mic 

Memory Up to 5GB DDR3 1066MHz (1 GB down + 1 slot) 

Storage HDD 160 GB 5400 RPM SATA 

  SSD 64 GB Mobility, 128 GB FDE SSD 

Display 12.1" WXGA DLV Outdoor-Readable (400 nits)  

Camera  Optional (IP54-rated) integrated 2.0MP camera 

Ports 
1394, USB 2.0 (x2), USB 2.0/eSATA, VGA, RJ-45 , Audio, External Antenna 
Connection (RF pass thru) 

Expansion  Express 54 (34 and 54mm support), SD Card slot 

Docking Vehicle Docking, Desktop Media Bay, Tri-Mode RF Pass-through 

ODD 
External E-Family modular media bay: 8X DVD-ROM, 24X CDRW/DVD, 8X DVD+/-RW, 
2nd Hard Drive 

Battery  4-cell 28W/Hr Li-Ion primary (standard) 

  6-cell 42W/Hr Li-Ion primary (optional) 

Ethernet 10/100/1000 base-T Ethernet 

WLAN  Up to Intel® WiFi® Link 5300 (802.11a/g/Draft n 3x3) 

WPAN  Dell 365 Bluetooth® Module 

WWAN  Dell Wireless 5720 EV-DOrA Mobile Broadband1 Minicard 

  Dell Wireless 5530 HSUPA/HSDPA Mobile Broadband1 Minicard, GOBI 

GPS  Optional GPS Receiver or 2.0MP Camera 

Security  
Dell ControlVault®, Dell ControlPoint Security ManagerCable lock slot, Integrated 
Smart Card Reader, Fingerprint Reader, Computrace Option, TPM 1.2 

Ergonomics  12.2" x 9.6" x 1.49" 

Weight  Starting at <5.5 lbs 
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6 Dell Diagnostics 
 CAUTION: Before you begin any of the procedures in this section, follow the safety 

instructions that shipped with your computer. 

 
When to Use the Dell Diagnostics 
If you experience a problem with your computer, perform the checks in Solving Problems, and then 
run the Dell Diagnostics before contacting Dell for assistance. 
 
Start the Dell Diagnostics from your hard drive or from the Drivers and Utilities media provided with 
your computer. 
 

 NOTE: The Drivers and Utilities media is optional and may not ship with your computer. 

 NOTE: The Dell Diagnostics only operate on Dell computers. 

 
Starting the Dell Diagnostics From Your Hard Drive 
Before running the Dell Diagnostics, enter system setup to review your computer’s configuration 
information, and ensure that the device you want to test is displayed in system setup and is active. 
For more information on using the system setup program, see the Dell™ Technology Guide on your 
computer or at support.dell.com. 
 
The Dell Diagnostics is located on a separate diagnostic utility partition on your hard drive. 

 NOTE: If the computer is connected to a docking device (docked), undock it. See the 
documentation that came with your docking device for instructions. 

 NOTE: If your computer does not display a screen image, contact Dell Support. 

 
1. Ensure that the computer is connected to an electrical outlet that is known to be working 

properly. 
2. Press and hold the <Fn> key or the mute button then turn on your computer. 

 

 NOTE: Alternatively, you can select Diagnostics from the one-time boot menu at startup to boot 
to the diagnostic utility partition and run the Dell Diagnostics. 

 
The computer runs the Pre-boot System Assessment (PSA), a series of initial tests of your system 
board, keyboard, display, memory, hard drive, etc. 
 

• During the assessment, answer any questions that appear. 
• If failures are detected during the Pre-boot System Assessment, write down the error code(s) 

and contact Dell Support. 
• If the Pre-boot System Assessment completes successfully, the following message appears: 

"Booting Dell Diagnostic Utility Partition. Press any key to continue." 
 

 NOTE: If you see a message stating that no diagnostics utility partition has been found, run the 
Dell Diagnostics from your Drivers and Utilities media (see Starting the Dell Diagnostics From the 
Drivers and Utilities Media). 

 
3. Press any key to start the Dell Diagnostics from the diagnostics utility partition on your hard 

drive. 
4. Press <Tab> to select Test System and then press <Enter>. 



Dell™ Latitude™ XT2 XFR Service Manual 
 

 

Page 75 of 94                                               Version A00-01 

 

 NOTE: It is recommended that you select Test System to run a complete test on your 
computer. Selecting Test Memory initiates the extended memory test which can take up to 
thirty minutes or more to complete. When the test completes, record the test results and then 
press any key to return to the previous menu. 

 
5. At the Dell Diagnostics Main Menu, left-click with the touch pad/mouse, or press <Tab> and 

then <Enter>, to select the test you want to run (see Dell Diagnostics Main Menu). 
 

 NOTE: Write down any error codes and problem descriptions exactly as they appear and follow 
the instructions on the screen. 

 
6. After all tests have completed, close the test window to return to the Dell Diagnostics Main 

Menu. 
7. Close the Main Menu window to exit the Dell Diagnostics and restart the computer. 

 

 NOTE: If you see a message stating that no diagnostics utility partition has been found, run the 
Dell Diagnostics from your Drivers and Utilities media (see Starting the Dell Diagnostics From the 
Drivers and Utilities Media). 

Starting the Dell Diagnostics From the Drivers and Utilities Media 
Before running the Dell Diagnostics, enter system setup to review your computer’s configuration 
information, and ensure that the device you want to test is displayed in system setup and is active. 
For more information on using the system setup program, see the Dell™ Technology Guide on your 
computer or at support.dell.com. 
 

1. Insert the Drivers and Utilities media into the optional external optical drive. 
2. Restart your computer. 
3. When the DELL logo appears, press <F12> immediately. 

 

 NOTE: Keyboard failure may result when a key is held down for extended periods of time. To 
avoid possible keyboard failure, press and release <F12> in even intervals to open the Boot 
Device Menu. 

 
If you wait too long and the operating system logo appears, continue to wait until you see the 
Microsoft Windows desktop, then shut down your computer and try again. 

 
4. When the boot device list appears, use the up- and down-arrow keys to highlight 

CD/DVD/CD-RW Drive, and then press <Enter>. 
  

 NOTE: Using the one-time boot menu changes the boot sequence for the current boot only. Upon 
restart, the computer boots according to the boot sequence specified in system setup. 

 
5. Press any key to confirm that you want to start from the CD/DVD 

If you wait too long and the operating system logo appears, continue to wait until you see the 
Microsoft Windows desktop, then shut down your computer and try again. 
 

6. Type 1 to Run the 32 Bit Dell Diagnostics. 
7. At the Dell Diagnostics Menu, type 1 to select Dell 32-bit Diagnostics for Resource CD 

(graphical user interface). 
8. Press <Tab> to select Test System and the press <Enter>. 

 

 NOTE: It is recommended that you select Test System to run a complete test on your 
computer. Selecting Test Memory initiates the extended memory test which can take up to 
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thirty minutes or more to complete. When the test completes, record the test results and then 
press any key to return to the previous menu. 

 
9. At the Dell Diagnostics Main Menu, left-click with the touch pad/mouse, or press <Tab> and 

then <Enter>, to select the test you want to run (see Dell Diagnostics Main Menu). 
 

 NOTE: Write down any error codes and problem descriptions exactly as they appear and follow 
the instructions on the screen. 

 
10. After all tests have completed, close the test window to return to the Dell Diagnostics Main 

Menu. 
11. Close the Main Menu window to exit the Dell Diagnostics and restart the computer. 
12. Remove the Drivers and Utilities media from the optical drive. 

Dell Diagnostics Main Menu 
 
After the Dell Diagnostics loads, the following menu appears: 
 

Option Function 
Test Memory Run the stand-alone memory test 

Test System Run system diagnostics 

Exit Exit the diagnostics 

 
Press <Tab> to select the test you want to run and then press <Enter>. 
 

 NOTE: It is recommended that you select Test System to run a complete test on your 
computer. Selecting Test Memory initiates the extended memory test which can take up to 
thirty minutes or more to complete. When the test completes, record the test results and then 
press any key to return to the previous menu. 

 
After Test System is selected, the following menu appears: 
 

Option Function 
 
Express Test 

 
Performs a quick test of devices in the system.  This typically 
can take 10 to 20 minutes. 
 
NOTE: The Express Test requires no interaction on your part.  
Run Express Test first to increase the possibility of tracing a 
problem quickly. 

 
Custom Test 

 
Use to test a specific device or customize the tests to be run. 

 
Symptom Tree 

 
This option allows you to select tests based on a symptom of 
the problem you are having.  This option lists the most 
common symptoms. 

 

 NOTE: It is recommended that you select Extended Test to perform a more thorough check of 
devices in the computer. 

 
For any problem encountered during a test, a message appears with an error code and a description of 
the problem. Write down the error code and problem description exactly as it appears and follow the 
instructions on the screen. If you cannot resolve the problem, contact Dell Support. 
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 NOTE: When contacting Dell Support, have your Service Tag ready.  The Service Tag for your 
computer is located at the top of each test screen. 

 
The following tabs provide additional information for tests run from the Custom Test or Symptom Tree 
option: 
 

Tab Function 
 
Results 

 
Displays the results of the test and any error conditions 
encountered. 

 
Errors 

 
Displays error conditions encountered, error codes, and the 
problem description. 

 
Help 

 
Describes the test and any requirements for running the test. 

 
Configuration 

 
Displays the hardware configuration for the selected device. 
 
The Dell Diagnostics obtains configuration information for all 
devices from System Setup, memory, and various internal 
tests, and displays the information in the device list in the left 
pane of the screen. 
 
NOTE: The device list may not display the names of all 
components installed on your computer or all devices attached 
to your computer. 

 
Parameters 

 
Allows you to customize the test, if applicable, by changing the 
test settings. 

 

6.1.1 Error Messages 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
If the error message is not listed, see the documentation for the operating system or the program that 
was running when the message appeared. 
 
A FILENAME CANNOT CONTAIN ANY OF THE FOLLOWING CHARACTERS: \ / : * ? “ < 
> | — Do not use these characters in filenames. 
 
A REQUIRED .DLL FILE WAS NOT FOUND — The program that you are trying to open 
is missing an essential file. To remove and then reinstall the program: 
 
Windows XP: 

1. Click Start→ Control Panel→ Add or Remove Programs→ Programs and Features. 
2. Select the program you want to remove. 
3. Click Uninstall. 
4. See the program documentation for installation instructions. 

 
Windows Vista: 

1. Click Start → Control Panel→ Programs→ Programs and Features. 
2. Select the program you want to remove. 
3. Click Uninstall. 
4. See the program documentation for installation instructions. 
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drive letter :\ IS NOT ACCESSIBLE. THE DEVICE IS NOT READY — The drive cannot read the 
disk. Insert a disk into the drive and try again. 
 
INSERT BOOTABLE MEDIA — Insert a bootable floppy disk, CD, or DVD. 
 
NON-SYSTEM DISK ERROR — Remove the floppy disk from the floppy drive and restart your 
computer. 
 
NOT ENOUGH MEMORY OR RESOURCES. CLOSE SOME PROGRAMS AND TRY 
AGAIN — Close all windows and open the program that you want to use. In some cases, you may 
have to restart your computer to restore computer resources. If so, run the program that you want to 
use first. 
 
OPERATING SYSTEM NOT FOUND — Contact Dell Support. 

6.2 Solving Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
Follow these tips when troubleshooting your computer: 

• If you added or removed a part before the problem started, review the installation procedures 
and ensure that the part is correctly installed. 

• If a peripheral device does not work, ensure that the device is properly connected. 
• If an error message appears on the screen, write down the exact message. This message may 

help support personnel diagnose and fix the problem(s). 
• If an error message occurs in a program, see the program’s documentation. 

 

 NOTE: The procedures in this document were written for the Windows default view, so they may 
not apply if you set your Dell computer to the Windows Classic view. 

 

6.2.1 Battery Problems 

 CAUTION: There is a danger of a new battery exploding if it is incorrectly installed. 
Replace the battery only with the same or equivalent type recommended by the 
manufacturer. Discard used batteries according to the manufacturer's instructions. 

 

6.2.2 Drive Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
ENSURE THAT MICROSOFT WINDOWS RECOGNIZES THE DRIVE — 
 
Windows XP: 

• Click Start and click My Computer. 
 
Windows Vista: 

• Click the Windows Vista Start button and click Computer. 
 
If the drive is not listed, perform a full scan with your antivirus software to check for and remove 
viruses. Viruses can sometimes prevent Windows from recognizing the drive. 
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TEST THE DRIVE — 
• Insert another disc to eliminate the possibility that the original drive is defective. 
• Insert a bootable floppy disk and restart the computer. 

 
CLEAN THE DRIVE OR DISK — For information on cleaning your computer, see the Dell™ 
Technology Guide on your computer or at support.dell.com. 
 
CHECK THE CABLE CONNECTIONS 
 
RUN THE HARDWARE TROUBLESHOOTER — See Hardware Troubleshooter. 
 
RUN THE DELL DIAGNOSTICS — See Dell Diagnostics. 
 
Optical Drive Problems 
 

 NOTE: High-speed optical drive vibration is normal and may cause noise, which does not indicate 
a defect in the drive or the media. 

 NOTE: Because of different regions worldwide and different disc formats, not all DVD titles work 
in all DVD drives. 

 
ADJUST THE WINDOWS VOLUME CONTROL — 

• Click the speaker icon in the lower-right corner of your screen. 
• Ensure that the volume is turned up by clicking the slidebar and dragging it up. 
• Ensure that the sound is not muted by clicking any boxes that are checked. 

 
CHECK THE SPEAKERS AND SUBWOOFER — See Sound and Speaker Problems. 
 
Problems writing to an optical drive 
 
CLOSE OTHER PROGRAMS — The optical drive must receive a steady stream of data during the 
writing process. If the stream is interrupted, an error occurs. Try closing all programs before you write 
to the optical. 
 
TURN OFF STANDBY MODE IN WINDOWS BEFORE WRITING TO A DISC — For information 
about setting power options, see the Dell™ Technology Guide on your computer or at 
support.dell.com. You can also search for the keyword standby in Windows Help and Support for 
information on power management modes. 
 
Hard Drive Problems 
 
RUN CHECK DISK — 
 
Windows XP: 

1. Click Start and click My Computer. 
2. Right-click Local Disk C:. 
3. Click Properties→ Tools→ Check Now. 
4. Click Scan for and attempt recovery of bad sectors and click Start. 

 
Windows Vista: 

1. Click Start and click Computer. 
2. Right-click Local Disk C:. 
3. Click Properties→ Tools→ Check Now. 

The User Account Control window may appear. If you are an administrator on the computer, 
click Continue; otherwise, contact your administrator to continue the desired action. 

4. Follow the instructions on the screen. 
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6.2.3 IEEE 1394 Device Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 NOTE: Your computer supports only IEEE 1394a standard. 

 
ENSURE THAT THE CABLE FOR THE IEEE 1394 DEVICE IS PROPERLY INSERTED INTO 
THE DEVICE AND INTO THE CONNECTOR ON THE COMPUTER 
 
ENSURE THAT THE IEEE 1394 DEVICE IS ENABLED IN SYSTEM SETUP — For more information 
on using the system setup program, see the Dell™ Technology Guide on your computer or at 
support.dell.com. 
 
ENSURE THAT THE IEEE 1394 DEVICE IS RECOGNIZED BY WINDOWS — 
 
Windows XP: 

5. Click Start and click Control Panel. 
6. Under Pick a Category, click Performance and Maintenance→ System→ System 

Properties → Hardware→ Device Manager. 
 
Windows Vista: 

Click Start → Control Panel→ Hardware and Sound. 
Click Device Manager. If your IEEE 1394 device is listed, Windows recognizes the device. 
 
IF YOU HAVE PROBLEMS WITH A DELL IEEE 1394 DEVICE — Contact Dell Support. 
 
IF YOU HAVE PROBLEMS WITH AN IEEE 1394 DEVICE NOT PROVIDED BY DELL — Contact the 
IEEE 1394 device manufacturer. 

6.2.4 Lockups and Software Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
The Computer Does Not Start Up 
 
CHECK THE DIAGNOSTIC LIGHTS — See Power Problems. 
 
ENSURE THAT THE POWER CABLE IS FIRMLY CONNECTED TO THE COMPUTER AND TO THE 
ELECTRICAL OUTLET 
 
The computer stops responding 

 
NOTICE: You may lose data if you are unable to perform an operating system shutdown. 

 
TURN THE COMPUTER OFF — If you are unable to get a response by pressing a key on your 
keyboard or moving your mouse, press and hold the power button for at least 8 to 10 seconds (until 
the computer turns off), and then restart your computer. 
 
A Program Stops Responding 
END THE PROGRAM — 

1. Press <Ctrl><Shift><Esc> simultaneously to access the Task Manager. 
2. Click the Applications tab. 
3. Click to select the program that is no longer responding. 
4. Click End Task. 
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A Program Crashes Repeatedly 

 NOTE: Most software includes installation instructions in its documentation or on a floppy disk, 
CD, or DVD. 

 
CHECK THE SOFTWARE DOCUMENTATION — If necessary, uninstall and then reinstall the 
program. 
 
A Program is Designed for an Earlier Windows Operating System 
 
RUN THE PROGRAM COMPATIBILITY WIZARD — 
 
Windows XP: 
The Program Compatibility Wizard configures a program so that it runs in an environment similar to 
non-XP operating system environments. 

1. Click Start→ All Programs→ Accessories→ Program Compatibility Wizard→ Next. 
2. Follow the instructions on the screen. 

 
Windows Vista: 
The Program Compatibility Wizard configures a program so that it runs in an environment similar to 
non-Windows Vista operating system environments. 

1. Click Start → Control Panel→ Programs→ Use an older program with this version of 
Windows. 

2. In the welcome screen, click Next. 
3. Follow the instructions on the screen. 

 
A Solid Blue Screen Appears 
 
TURN THE COMPUTER OFF — If you are unable to get a response by pressing a key onyour 
keyboard or moving your mouse, press and hold the power button for at least 8 to 10 seconds (until 
the computer turns off), and then restart your computer. 
 
Other Software Problems 
 
CHECK THE SOFTWARE DOCUMENTATION OR CONTACT THE SOFTWARE MANUFACTURER 
FOR TROUBLESHOOTING INFORMATION — 

• Ensure that the program is compatible with the operating system installed on your computer. 
• Ensure that your computer meets the minimum hardware requirements needed to run the 

software. See the software documentation for information. 
• Ensure that the program is installed and configured properly. 
• Verify that the device drivers do not conflict with the program. 
• If necessary, uninstall and then reinstall the program. 

 
BACK UP YOUR FILES IMMEDIATELY 
 
USE A VIRUS-SCANNING PROGRAM TO CHECK THE HARD DRIVE, FLOPPY DISKS, CDS, OR 
DVDS 
 
SAVE AND CLOSE ANY OPEN FILES OR PROGRAMS AND SHUT DOWN YOUR COMPUTER 
THROUGH THE START MENU 

6.2.5 Memory Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
IF YOU RECEIVE AN INSUFFICIENT MEMORY MESSAGE — 
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Save and close any open files and exit any open programs you are not using to see if that resolves the 
problem. 

• See the software documentation for minimum memory requirements. If necessary, install 
additional memory (see Replacing a Memory Module). 

• Reseat the memory modules (see Memory) to ensure that your computer is successfully 
communicating with the memory. 

• Run the Dell Diagnostics (see Dell Diagnostics). 
 
IF YOU EXPERIENCE OTHER MEMORY PROBLEMS — 

• Reseat the memory modules (see Memory) to ensure that your computer is successfully 
communicating with the memory. 

• Ensure that you are following the memory installation guidelines (see Replacing a Memory 
Module). 

• Ensure that the memory you are using is supported by your computer. For more information 
about the type of memory supported by your computer, see the Setup and Features 
Information Guide for your computer at support.dell.com. 

• Run the Dell Diagnostics (see Dell Diagnostics). 

6.2.6 Power Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
IF THE POWER LIGHT IS BLUE AND THE COMPUTER IS NOT RESPONDING — See Diagnostic 
Lights. 
 
IF THE POWER LIGHT IS OFF — The computer is either turned off or is not receiving power. 

• Reseat the power cable in the power connector on the back of the computer and the electrical 
outlet. 

• Bypass power strips, power extension cables, and other power protection devices to verify that 
the computer turns on properly. 

• Ensure that any power strips being used are plugged into an electrical outlet and are turned 
on. 

• Ensure that the electrical outlet is working by testing it with another device, such as a lamp. 
 
ELIMINATE INTERFERENCE — Some possible causes of interference are: 

• Power, keyboard, and mouse extension cables 
• Too many devices connected to the same power strip 
• Multiple power strips connected to the same electrical outlet 

6.2.7 Sound and Speaker Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 NOTE: The volume control in MP3 and other media players may override the Windows volume 
setting. Always check to ensure that the volume on the media player(s) has not been turned 
down or off. 

 
ADJUST THE WINDOWS VOLUME CONTROL — Click or double-click the speaker icon in the lower-
right corner of your screen. Ensure that the volume is turned up and that the sound is not muted. 
 
DISCONNECT HEADPHONES FROM THE HEADPHONE CONNECTOR — Sound from the speakers is 
automatically disabled when headphones are connected to the computer’s front-panel headphone 
connector. 
 
ELIMINATE POSSIBLE INTERFERENCE — Turn off nearby fans, fluorescent lights, or halogen lamps 
to check for interference. 
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RUN THE HARDWARE TROUBLESHOOTER — See Hardware Troubleshooter. 
 
No Sound From Headphones 
 
CHECK THE HEADPHONE CABLE CONNECTION — Ensure that the headphone cable is securely 
inserted into the headphone connector. See the Setup and Features Information Guide for your 
computer at support.dell.com. 
 
ADJUST THE WINDOWS VOLUME CONTROL — Click or double-click the speaker icon in the lower-
right corner of your screen. Ensure that the volume is turned up and that the sound is not muted. 

6.2.8 Video and Display Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the safety 
instructions that shipped with your computer. 

 
NOTICE: If your computer came with a PCI graphics card installed, removal of the card is not 
necessary when installing additional graphics cards; however, the card is required for 
troubleshooting purposes. If you remove the card, store it in a safe and secure location. For 
information about your graphics card, go to support.dell.com. 

 
CHECK THE DIAGNOSTIC LIGHTS — See Diagnostic Lights. 
 
CHECK THE DISPLAY SETTINGS — See the Dell™ Technology Guide on your computer or at 
support.dell.com. 
 
ADJUST THE WINDOWS DISPLAY SETTINGS — 
 
Windows XP: 

1. Click Start→ Control Panel→ Appearance and Themes. 
2. Click the area you want to change or click the Display icon. 
3. Try different settings for Color quality and Screen resolution. 

 
Windows Vista: 

1. Click Start → Control Panel→ Hardware and Sound→ Personalization→ Display 
Settings. 

2. Adjust Resolution and Colors settings, as needed. 
 
Only Part of the Display is Readable 
 
CONNECT AN EXTERNAL MONITOR — 

1. Shut down your computer and connect an external monitor to the computer. 
2. Turn on the computer and the monitor and adjust the monitor brightness and contrast 

controls. 
 
If the external monitor works, the computer display or video controller may be defective. Contact Dell 
Support. 

6.3 Dell Technical Update Service 
The Dell Technical Update service provides proactive e-mail notification of software and hardware 
updates for your computer. The service is free and can be customized for content, format, and how 
frequently you receive notifications. 
 
To enroll for the Dell Technical Update service, go to support.dell.com. 
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6.4 Dell Support Utility 
The Dell Support Utility is installed on your computer and available from the Dell Support, , icon on 
the taskbar or from the Start button. Use this support utility for self-support information, software 
updates, and health scans of your computing environment. 
 
Accessing the Dell Support Utility 

Access the Dell Support Utility from the  icon on the taskbar or from the Start menu. 
 
If the Dell Support icon does not appear in your taskbar: 

1. Click Start→ All Programs→ Dell Support→ Dell Support Settings. 
2. Ensure that the Show icon on the taskbar option is checked. 

 NOTE: If the Dell Support Utility is not available from the Start menu, go to support.dell.com 
and download the software. 

The Dell Support Utility is customized for your computing environment. The  icon in the taskbar 
functions differently when you click, double-click, or right-click the icon. 

6.4.1 Clicking the Dell Support Icon 
Click or right-click the  icon to perform the following tasks: 

• Check your computing environment. 
• View the Dell Support Utility settings. 
• Access the help file for the Dell Support Utility. 
• View frequently asked questions. 
• Learn more about the Dell Support Utility. 
• Turn the Dell Support Utility off. 

6.4.2 Double-Clicking the Dell Support Icon 
Double-click the  icon to manually check your computing environment, view frequently asked 
questions, access the help file for the Dell Support Utility, and view Dell Support settings. 
 
For more information about the Dell Support Utility, click the question mark (?) at the top of the 
Dell™ Support screen. 
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6.5 GPS Device 
Follow the directions in the hot swappable modules section above to install the GPS device. Ensure the 
GPS device is properly seated and the lock is in the locked position. 

6.5.1 GPS Hardware Configuration 
It is important that you configure your computer’s hardware settings properly to allow the GPS device 
to operate. The following instructions show the proper process to configuring a communications port 
for the GPS to operate in. 
 

1. Click on the Start button and right-click on Computer; then click on Properties.  
2. Click on Device Manager.  
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3. Double-click on “Ports”. Right-click on the USB Serial Port (COM#) device and select 
Properties.  
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4. Select the Port Settings tab. Confirm that the following settings are assigned to each field 
shown below:  
  
Bits per second: 4800  
Data bits: 8  
Parity: none  
Stop bits: 1  
Flow control: None  

 

6.5.2 Software Configuration 
There are many off the shelf and usage specific applications available that are compatible with this 
GPS module. Additional configuration may be required to allow the software to function with the GPS 
module. Please follow the instructions provided by your software manufacturer. 
 

6.5.3 Diagnostics 
Performing Dell Diagnostics on USB devices will locate the GPS as a connected device and run a ping 
test on the GPS installed.  A pass indicates the GPS is installed and using the USB bus properly. 
 
If the USB device test fails the GPS only, replace the GPS module.  If the ping test does not recognize 
a GPS module is attached, a replacement USB hub board may be needed or the USB cable checked for 
proper connection.  If no USB devices are present, replace the system board. 
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6.6 Camera 
Follow the directions in the Hot Swappable Module Devices section above to install the Camera device.  
Ensure the camera is properly seated and the lock is in the locked position. 

6.6.1 Camera Configuration Verification 
If the camera is not working, or is working intermittently, use the following steps to verify the camera 
configuration. 
 

1. Click on the Start button and right-click on Computer; then click on Properties.  
2. Click on Device Manager.  
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3. Double-click on “Imaging Device”, and locate “USB UVC Webcam”. 
 

 
 

a. If a ‘Yellow Bang” appears on the device, then the drivers should be reinstalled. 
b. If “USB UVC Webcam” is under Device Manager, but the camera is non-functional, 

locate the “USB Composite Device” and look at the “General” tab in the 
“Properties” for the “USB Composite Device”. If a “Down Arrow” appears over the 
USB icon for the device, then the device is installed but needs to be enabled. 
 

4. Verify that the messaging application does not have the camera disabled or turned off. 
 

6.6.2 Diagnostics 
Performing Dell Diagnostics on USB devices will locate the camera as a connected device and run a 
ping test on the camera installed.  A pass indicates the camera is installed and using the USB bus 
properly. 
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If the USB device test fails the Camera only, replace the Camera module.  If the ping test does not 
recognize a Camera module is attached, a replacement USB hub board may be needed or the USB 
cable checked for proper connection.  If no USB devices are present, replace the system board. 
 
 
 

6.7 Device Status LEDs 

Device status LEDs are a good source for diagnosing common problems that may occur on 
your XT2 XFR.  

 
Turns on when you turn on the XT2 XFR and blinks when the XT2 
XFR is in a power management mode. 

 
Turns on when the XT2 XFR reads or writes data. 

 
Turns on steadily or blinks to indicate battery charge status. 

 
Turns on when wireless networking is enabled. 

 

Turns on when a card with Bluetooth® wireless technology is 
enabled. To turn off only the Bluetooth wireless technology function, 
right-click the icon in the system tray and select Disable Bluetooth 
Radio. 

 
Battery Status 

If the computer is connected to an electrical outlet, the battery light operates as follows: 

• Alternately blinking amber light and blue light — An unauthenticated or unsupported, 
non-Dell AC adapter is attached to your XT2 XFR.  

• Alternately blinking amber light with steady blue light — Temporary battery failure with 
AC adapter present.  

• Constantly blinking amber light — Fatal battery failure with AC adapter present.  
• Light off — Battery in full charge mode with AC adapter present.  
• Blue light on — Battery in charge mode with AC adapter present. 

 

Battery Charge and Health 

To check the battery charge, press and release the status button on the battery charge 
gauge to illuminate the charge-level lights. Each light represents approximately 20 percent 
of the total battery charge. For example, if four lights are on, the battery has 80 percent of 
its charge remaining. If no lights appear, the battery has no charge. 

To check the battery health using the charge gauge, press and hold the status button on the 
battery charge gauge for at least 3 seconds. If no lights appear, the battery is in good 
condition and more than 80 percent of its original charge capacity remains. Each light 
represents incremental degradation. If five lights appear, less than 60 percent of the charge 
capacity remains, and you should consider replacing the battery. 
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6.8  Keyboard Status LEDs 

The green lights located above the keyboard indicate the following: 

 

Turns on when the numeric keypad is 
enabled. 

 

Turns on when the Caps Lock function is 
enabled. 

 

Turns on when the Scroll Lock function is 
enabled. 

6.9  LED Error Codes 

Appearance Description Next Step 

ON-OFF-OFF 

 

No 
SODIMMs 

are installed 

1. Install supported 
memory modules.  

2. If memory is already 
present, reseat the 
module(s) one at 
time in each slot.  

3. Try known good 
memory from 
another computer or 
replace the memory.  

4. Replace the system 
board.  

FLASH-ON-ON 

 

System 
board error 

1. Reseat the 
processor.  

2. Replace the system 
board.  

3. Replace the 
processor.  

FLASH-ON-FLASH 

 

LCD Panel 
Error 

1. Reseat the LCD 
cable.  

2. Replace the LCD 
panel.  

3. Replace the video 
card / system board. 

OFF-FLASH-OFF 

 

Memory 
compatibility 

error 

1. Install compatible 
memory modules.  

2. If two modules are 
installed remove one 
and test. Try the 
other module in the 
same slot and test. 
Test the other slot 
with both modules.  

3. Replace the 
memory.  
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4. Replace the system 
board.  

ON-FLASH-ON 

 

Memory is 
detected but 
has errors 

1. Reseat the memory.  
2. If two modules are 

installed remove one 
and test. Try the 
other module in the 
same slot and test. 
Test the other slot 
with both modules.  

3. Replace the memory  
4. Replace the system 

board.  

OFF-FLASH-FLASH 

 

Modem 
Error 

1. Reseat the modem.  
2. Replace the modem.  
3. Replace the system 

board.  

FLASH-FLASH-FLASH 

 

System 
board error 

1. Replace the system 
board.  

FLASH-FLASH-OFF 

 

Option ROM 
Error 

1. Reseat the device.  
2. Replace the device.  
3. Replace the system 

board. 

OFF-ON-OFF 

 

Storage 
device error 

1. Reseat the hard 
drive and optical 
drive.  

2. Test the computer 
with just the hard 
drive and just the 
optical drive.  

3. Replace the device 
that is causing the 
failure.  

4. Replace the system 
board. 

OFF-ON-OFF 

 

Video card 
error 

1. Replace the system 
board. 
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7 System BIOS 

Your XT2 XFR offers the following system BIOS options: 

• Bring up a one-time boot menu by pressing <F12>  
• Access the System Setup utility by pressing <F2> 

7.1  BIOS Screen Navigation Keystrokes 

Use the following keystrokes to navigate the BIOS screens. 

Navigation Keystrokes 

Action Keystroke 

Expand and collapse field <Enter>, left- and right-arrow keys, or +/– 

Expand or collapse all fields < > 

Exit BIOS <Esc> — Remain in Setup, Save/Exit, Discard/Exit 

Change a setting Left- and right-arrow keys 

Select field to change <Enter> 

Cancel a modification <Esc> 

Reset defaults <Alt><F> or Load Defaults menu option 

 NOTE: Depending on your computer and any installed devices, the items listed in this section 
may or may not appear.  

7.2  <F12> Menu 

Press <F12> when the Dell™ logo appears to initiate a one-time boot menu with a list of 
the valid boot devices for the system. Diagnostics and Enter Setup options are also 
included in this menu. The devices listed on the boot menu depend on the bootable devices 
in the system. This menu is useful when you are attempting to boot to a particular device or 
to bring up the diagnostics for the system. Using the boot menu does not make any 
changes to the boot order stored in the BIOS. 

Boot Menu 
Your XT2 XFR features an enhanced one-time boot menu. The enhanced menu features the following 
improvements:  

• Easier access — Access the menu by pressing <F12> during system boot.  
• User prompting — The missing keystroke is now displayed on the BIOS splash screen.  
• Added diagnostics options — The boot menu now includes two new options: BIOS Setup 

and Diagnostics.  

7.3  Entering System Setup 
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Press <F2> to enter System Setup and change the user-definable settings. If you have 
trouble entering System Setup using this key, press <F2> when the keyboard LEDs first 
flash. 

Follow the on-screen instructions to view and/or change any settings. On each screen, the 
system setup options are listed at the left. To the right of each option is the setting or value 
for that option. You can change settings that appear as white type on the screen. Options or 
values that you cannot change (because they are determined by your XT2 XFR) appear less 
bright. 

The upper-right corner of the screen displays help information for the currently highlighted 
option. The lower-right corner displays information about the computer. System setup key 
functions are listed across the bottom of the screen. 

The system setup screens display the current setup information and settings for your 
computer, such as: 

• System configuration  
• Boot order  
• Boot (start-up) configuration  
• Basic device configuration settings  
• System security and hard drive password setting 
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